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Microsoft Office 2003 Introduction

Welcome to Microsoft® Office Word 2003, part of Microsoft Office 2003 Editions—the easiest way to help more people use information to make a positive impact on business. The Office 2003 Editions offer new technologies and features while improving upon existing and familiar tools to facilitate effective and efficient collaboration and information sharing.

This document delivers an overview of the Office 2003 Editions, including how they can help you connect people and business processes, as well as get valuable help services online. We’ll take a close look at Word 2003 in action, providing guidance on the specific details of this integral part of Office 2003 Editions.

Through integration with Microsoft Windows® SharePoint™ Services, the Office 2003 Editions offer advances in intranet collaboration to help users gain access to and share information both internally and externally. Support for Information Rights Management (IRM) and industry-standard Extensible Markup Language (XML) provides a platform on which to build cost-effective solutions that can have an immediate, positive impact. In addition, the Office 2003 Editions offer new ways to organize and manage e-mail and make more use out of the workday.

Design Goals

With a focus on connecting people, information, and business processes, the design goals integrate collaboration, usability, and information management.

Connect people

Designed to integrate with intranet technologies such as Microsoft Windows SharePoint Services, the Office 2003 Editions provide new ways to connect individuals, teams, and organizations. By incorporating the new tools with familiar Microsoft Office menus, functions, and interfaces, training and implementation time is minimized. Workers can collaborate from any location by using shared information and simplified review processes, including the following features: 

· New! Shared Workspace task pane facilitates and simplifies efficient collaboration and document sharing.

· New! Shared Attachment option offers an automatic way of creating Document Workspaces through e-mail messages, when sending attachments for review. Document Workspaces provide a forum for managing collaborative review and projects, with features such as automatic updates to the most current version and the ability to share documents and other relevant information in real time.

· New! Meeting Workspace option automatically creates workspaces through Microsoft Office Outlook® invitations. Meeting Workspaces help enhance the productivity of meetings by providing a place to coordinate schedules, disseminate materials, and store notes and minutes.

· New! Instant messaging (IM) and Alerts technology is integrated throughout the Office 2003 Editions collaboration tools, providing instant information and the ability to initiate IM conversations quickly from within documents, Shared Workspaces, or Microsoft Office Outlook 2003. 

· New! Information Rights Management (IRM) functionality protects sensitive information from unauthorized distribution or alteration, and allows companies to set and enforce policies that help control how their data is used.

· New! Word 2003 Formatting and Editing Restrictions maintain formatting structure and document integrity.

Connect information

The Office 2003 Editions are designed to make it easier for people to manage an ever-increasing volume of business information. Improvements and new features in Outlook 2003 enable users to organize and prioritize e-mail messages quickly and easily, and new security settings offer increased support for junk e-mail filtering. Support for remote and mobile workers includes improvements to connectivity performance, such as better caching, and sharing calendars. Obtaining information from a variety of locations is made easier with organizational tools, such as the Research task pane. The following are new and improved features for connecting information:

· Improved! Enhanced Rules and Alerts provide automated organization of incoming e-mail messages, in addition to automatic notifications so that users can stay current with incoming e-mail messages without spending extra time doing so. Alerts can also be integrated with Document Workspaces to notify users about important project developments.

· Improved! Research task pane accesses needed information more efficiently. 
· Improved! Enhanced Ink support provides a better experience overall when using Tablet PCs, offering support for handwritten e-mail messages and the ability to write directly in Word 2003, Microsoft Office PowerPoint® 2003, and Microsoft Office Excel 2003 documents.
Connect business processes

Often, critical business information is kept separate from the programs that workers know and use. With its extensive support for industry-standard XML, the Office 2003 Editions help bring business processes and information together on the desktop. To facilitate greater efficiency, features such as Smart Documents and Programmable task panes help users share customizable, task-specific information easily. New and improved tools for connecting business processes include the following features: 

· New! Customer-defined XML schema support is available in Word 2003 and Excel 2003.

· New! Smart Documents bring relevant information directly to the task at hand through a new Programmable task pane user interface. With Smart Documents, XML solutions can be created to enable business processes, help users complete forms and other documents, and then link that information to back-end systems that support XML. As the user clicks through the document, the program is modified to present the appropriate functions to complete the task.

· [image: image24.jpg]


New! Extensible Smart Tag support is now offered in all the Office programs including PowerPoint 2003, Outlook 2003, and Access 2003. Support includes automatic configuration capabilities such as formatting and populating an index at the end of an article.

· New! XML support for Word 2003 includes content management options, data reporting, content repurposing, and data mining. 

System Recommendations

To use the Office 2003 Editions, here are the system requirements:

· Personal computer with an Intel Pentium 233-megahertz (MHz) or faster processor (Pentium III recommended)

· Microsoft Windows 2000 with Service Pack 3 (SP3) or later; or Microsoft Windows XP or later

· Super VGA (800 × 600) or a higher-resolution monitor

· 128 megabytes (MB) of RAM or more

Hard disk usage will vary depending on configuration; custom installation choices may require more or less hard disk space. The following are the hard disk requirements for individual Office 2003 Editions.

Microsoft Office Professional Edition 2003 

· 400 MB of available hard disk space; 190 MB of hard disk space for Microsoft Office Outlook® 2003 with Business Contact Manager

· Optional installation files cache (recommended) requires an additional 290 MB of available hard disk space

Microsoft Office Small Business Edition 2003 

· 380 MB of available hard disk space; 190 MB of additional hard disk space to use the optional installation of Outlook 2003 with Business Contact Manager

· Optional installation files cache (recommended) requires an additional 280 MB of available hard disk space

Microsoft Office Standard Edition 2003 

· 260 MB of available hard disk space

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space 

Microsoft Office Student and Teacher Edition 2003 

· 260 MB of available hard disk space

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space

Additional items or services

Some features or advanced functionality have additional requirements.

Microsoft Office Professional Edition 2003

To use the optional installation of Outlook 2003 with Business Contact Manager, you need to meet the following system requirements:

· A PC with a Pentium 450-MHz or faster processor. 

· 260 MB of RAM or more recommended. 

· 190 MB of additional hard disk space. 

For speech recognition: 

· Pentium II 400-MHz or faster processor. 

· Close-talk microphone and audio-output device. 

· Microsoft Exchange Server is required for certain advanced functionality in Outlook 2003.

Microsoft Windows Server™ 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality.

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply.

Specific inking features require running Microsoft Office XP Pack for Tablet PC (Tablet Pack) on the Tablet PC.

· Information Rights Management features require access to a Microsoft Windows 2003 Server running Windows Rights Management Services (RMS) for Windows Server™ 2003.

Note: Business Contact Manager will be disabled in the presence of an Exchange-technologies-based e-mail system.

Microsoft Office Small Business Edition 2003

· To use the optional installation of Outlook 2003 with Business Contact Manager you need to meet the following system requirements: 

· A PC with a Pentium 450-MHz or faster processor. 

· 260 MB of RAM or more recommended. 

· 190 MB of additional hard disk space. 

· For speech recognition: 

· Pentium II 400-MHz or higher processor.

· Close-talk microphone and audio output device. 

· Exchange is required for certain advanced functionality in Outlook 2003.

Note: Business Contact Manager will be disabled in the presence of an Exchange-technologies-based e-mail system. 

· Windows Server 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality.

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply. 

Office Standard Edition 2003

· For speech recognition: 

· Pentium II 400-MHz or faster processor. 

· Close-talk microphone and audio-output device. 

· Microsoft Exchange Server is required for certain advanced functionality in Outlook 2003.

· Microsoft Windows Server 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality.

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply. 

· Specific inking features require running Microsoft Office XP Pack for Tablet PC (Tablet Pack) on the Tablet PC.

This section examined the design goals, system recommendations, and additional services of Office 2003 Editions. The next two sections take a deeper look at Office 2003 Editions and how they facilitate connecting people and business processes, particularly through Word 2003.

Introduction 

Every employee faces challenges when a project requires team collaboration. The Microsoft Office 2003 Editions and the integration with Microsoft Windows SharePoint Services (WSS) provide a platform that includes programs employees use daily to work with other team members in a centralized location, making the team’s work more effective and efficient.

The Office 2003 Editions allow for closer teamwork experience. New task panes from within the documents and e-mail messages provide information about other team members and also offer access to resources. Team members can use Instant Messenger (IM) integration to see when other team members are online or offline. New calendar features in Microsoft Outlook 2003 make scheduling meetings with other team members quicker and more effective. The Office 2003 Editions also offer content protection rights to authors, ensuring that authors have complete access to and control over their documents.

Windows SharePoint Services Integration with Office 2003 Editions Programs

The integration of Office 2003 Editions programs and WSS offers users tools that are powerful and that make collaboration easier. A WSS site provides a virtual community for team collaboration, making it easy for users to work together on documents, projects, events, and other activities where information sharing is essential.

In addition to the new Workspaces, Outlook 2003 offers a workgroup server, offline availability, and multiple calendar views and lists. Microsoft Office Access 2003 has features that allow users to link tables to other SharePoint Web sites and preserve full read/write capabilities. Because Excel 2003 and the various SharePoint lists are integrated more closely, a user can import or export a list to or from Excel and share it with other team members. The Office 2003 Editions programs and WSS integration give users more opportunities for increased accessibility to view, edit, read, or write information within Word, Outlook, Access, and Excel.

The following table shows WSS integration features for each program in Office 2003 Editions:

	Windows SharePoint Site Feature
	

	Open and Save from File menu
	Excel, Outlook, PowerPoint, Publisher, Word

	Shared Workspace task pane
	Excel, PowerPoint, Word

	Document updates for shared attachments
	Excel, PowerPoint, Word

	Automatically collect metadata
	Word, Excel, PowerPoint

	Check-in / check-out
	Word, Excel, PowerPoint

	Version Tracking
	Word, Excel, PowerPoint

	Store inline discussions on the server
	Word, Excel, PowerPoint


Help Protect Sensitive Documents

New technologies in Office 2003 Editions help protect digital intellectual property. Information Rights Management (IRM) in Office 2003 Professional allows functions such as cut, copy, paste, print, and e-mail forwarding to be restricted for specific documents and e-mail messages, giving users and organizations more control over their valuable information assets. With Word 2003, in-document editing rights and style protection allow document owners to specify who is allowed to make changes.

Information Rights Management in Office 2003 Editions

IRM is a new policy enforcement technology in Office 2003 Editions that helps protect documents and e-mail messages from unauthorized access and use. IRM is a persistent, file-level protection technology that allows the owner to specify who can access a document or e-mail and control whether those users are allowed to edit, copy, forward, or print the contents. IRM is an extension of Windows Rights Management Services (RMS) into Microsoft Office 2003 programs. IRM in Office Professional 2003 Edition requires RMS on Windows Server 2003, either within the organization or through a service such as Microsoft Passport. Windows Rights Management Services for Windows Server 2003 is a new premium service that requires a separate Client Access License (CAL).

IRM is a policy enforcement technology, not a security technology, allowing documents and e-mail messages to be distributed while helping maintain control over who can access content and how they can use it. Once a document or e-mail is protected with this technology, the access and usage restrictions are enforced no matter where the file or e-mail goes. 

IRM support in Microsoft Office 2003 Editions helps corporations and knowledge-capital workers address two fundamental needs. It: 

· Helps protect digital intellectual property. Most corporations today rely on firewalls, login security, and other network technologies to protect their digital intellectual property. The fundamental limitation of these technologies is that, after legitimate users have access to the information, the information can be intentionally or accidentally shared with unauthorized people, creating a potential breach in security policies. IRM helps protect the information itself from unauthorized access and reuse.

· Helps ensure information privacy, control, and integrity Knowledge-capital workers often deal with confidential or sensitive information, relying on the discretion of others to keep sensitive materials in-house. IRM helps eliminate the risk of accidental leaks by disabling the forward, paste, or print functions in IRM-protected documents and e-mail messages. In addition, IRM can enforce expiration dates to help ensure that knowledge workers see and use up-to-date content only.

For IT managers, IRM helps enforce enterprise policies regarding document confidentiality, workflow, and e-mail retention. For CEOs and security officers, it helps reduce the risk of having key company information get into the hands of the wrong people, whether by accident, thoughtlessness, or malicious intent. 

When enabled by the organization, users of Office 2003 Editions will be able to easily take advantage of this technology. To create and protect documents and e-mail messages with IRM, Microsoft Office Professional Edition or the full stand-alone products are required. A simple user interface based on customizable “rights templates” available in the standard toolbar makes IRM convenient and easy to use. Other Microsoft Office 2003 Editions will give users the ability to read and edit IRM-protected content, but not create it. Integration with Active Directory® provides a level of convenience not seen on today’s document-specific passwords. 

Finally, IRM-protected documents and e-mail can be shared across organizations and with users that do not have Office 2003 Editions. Microsoft is offering, for a limited time, an IRM service for customers who do not host their own Windows Rights Management Services Server. The Rights Management Add-On for Internet Explorer allows Microsoft Windows users to consume IRM-protected documents whether or not they have Office 2003 Editions. This service will use Microsoft Passport, instead of Active Directory, as the authentication mechanism. Users of this service will not be able to create custom rights templates, such as a company’s confidential template, but they will be able to share and access IRM-protected documents and e-mail messages.

Leveraging Information Rights Management (IRM) in Word 2003 

IRM in Office Professional Edition 2003 allows the document owner to assign permissions to individual users and groups (groups based on Active Directory). In Word 2003, each user or group can be given a set of permissions according to the following roles: read, change, and full control. Depending on the recipient’s role, IRM disables certain commands to enforce the rights that are assigned. The document owner can also prevent printing and can set expiration dates. After expiration, documents cannot be opened.
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Users can apply usage restrictions to limit who can read, change, or control Excel 2003, Word 2003, and PowerPoint 2003 files.

Permission options 

If a protected document is forwarded to an unauthorized recipient, the document cannot be opened and an error message that contains the document owner’s e-mail appears so that the recipient can request additional rights. If the document owner decides not to include an e-mail address, unauthorized recipients get an error message. 

Organizational policies and template options

On the Windows Rights Management Services server, organizations can create “rights templates” that will appear in Office Professional Edition 2003 programs. For example, a company might define a template called Company Confidential, which specifies that a document or e-mail in that template can only be opened by users inside the company domain. These templates can reflect the policies of the organization, and the number of templates that can be created is unlimited.

Rights Management Add-On for Internet Explorer

Because enforcement of rights is done at the application level, Office files protected with IRM technology can only be opened and edited by Office 2003 Editions. However, Rights Management Add-On for Internet Explorer allows users without Office 2003 Editions to read IRM-protected materials. The Rights Management Add-On for Internet Explorer is available for download free of charge at www.microsoft.com (connect-time charges may apply).

The Rights Management Add-On for Internet Explorer will play an important role in communication between business units and with business partners, as companies may choose to migrate to Office 2003 Editions on their own timeframes. Companies can use IRM in Office 2003 Editions knowing that authorized users will be able to access and consume protected content even if they do not have Office 2003 Editions.

Additional server requirements

Microsoft Windows Server 2003 with Rights Management Services and Active Directory are required to enable IRM fully in Office Professional Edition 2003. The Rights Management Services feature requires a premium Client Access License (CAL). Microsoft is also hosting, for a limited time, an IRM service through Passport for customers who do not have Windows Server 2003. This service will enable users to share protected documents and e-mail by using Microsoft Passport as the authentication mechanism.

Note that users of Office Standard Edition 2003, Office Small Business Edition 2003, and Office Student and Teacher Edition 2003 cannot create new IRM-protected documents or e-mail messages, or modify the permissions on existing IRM-protected files. However, they can open, edit, save, and print IRM-protected documents and e-mail messages with the appropriate permissions.

Regional permissions

When teams collaborate on very large documents, some users may be assigned certain portions of the document to work on. In the past there was no way to ensure that each user only modified the assigned portion of the document. When it came time to reconcile the edits and merge changes into a master document, large numbers of conflicting edits often caused problems.

Document owners can set permissions to certain regions or specific portions of a document from being edited by some or all users. Using the Protect Document task pane (by selecting the Tools menu, and then Protect Document), a document owner can first protect the whole document against any edits (optionally allowing only comments), and then assign permissions to individual portions of the document by selecting them and specifying the users who should be able to edit that selected region. Later, when reconciling the changes of different individuals, the document owner is assured that no two people edited the same area, and no conflicts exist.
After the permissions have been set up, the task pane switches focus from helping the creator set up the permissions and manage the list of users to helping users find the parts of a document that they can edit. 
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User view of the Protect Document task pane.

Structured editing in Word 2003

Word 2003 includes additional features to allow a large number of users to collaborate on a large, sophisticated document in a structured way.

Formatting restrictions

Many large organizations need to produce documents that show a consistent style or appearance. Although this can be accomplished with Word styles, many users are not familiar with how styles function, and so they resort to formatting the document directly. Over time, large documents that include direct formatting become a burden to maintain because updating the styles does not change the appearance of the document, and moving portions of a document to another document does not produce the expected result. 

With Word 2003, users can set up a template or a document that uses a set of specific styles. By using the Formatting Restrictions feature of Word 2003, the user can enforce the use of only those specified styles. All direct formatting is disabled. This allows many people to edit the same complex document and still retain structured formatting. 
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Creator View of the Protect Document task pane.
Summary

The Office 2003 Editions and WSS integration make it easier and more efficient for users to connect with other team members and the information they need. By enhancing the desktop programs that employees are already familiar with, the Office 2003 Editions help users spend their time making progress on their projects instead of learning a new set of features and commands. Office Professional Edition 2003 also allows authors to create documents and e-mail messages that are better protected from unauthorized use by offering IRM technology. This improved functionality in the Office 2003 Editions assists users when working on projects that require team efforts.

Introduction

The Microsoft Office 2003 Editions integrate support for Extensible Markup Language (XML) in a way that can help companies create new, simple, and efficient processes for everyday business functions, such as creating invoices, contracts, press releases, reports, presentations, customer-facing e-mail messages, and more. The new processes combined with the power of XML can bring all departments together and save time by eliminating the need to pass documents back and forth among departments and people.

Business process management challenges

Because different departments in an organization have varying needs for consuming and reporting the same data, sharing information between departments can be difficult. Often, data output from one department is in the wrong form or file type to be opened or used by others. This means that departments must spend extra time reworking data to fit their needs and then verifying that it remains accurate.

Business value of XML in Office Professional Edition 2003

A surprising amount of business information stored today is already in XML format or can be easily converted to XML as it is used. All major database tools on the market today—from any vendor—support access to stored information by using XML format. A solution developer can request information as XML by using the correct interface, and the database server automatically generates the XML.

Support for customer-defined schemas in Office Professional Edition 2003 means that the data coming from these databases can be used directly in the Office programs. Likewise, data collected or created in Office Professional Edition 2003 can be submitted to existing databases without reworking the data.

With Office 2003 Editions, there is no need to wait for existing business information to be converted to XML—most of it is already available to power users and solution developers who are trying to make business processes more efficient. Although XML is implemented in all the Microsoft® Office 2003 Editions, this chapter focuses on XML implementation in Office Professional Edition 2003.

In Office Professional Edition 2003, the broad implementation of industry-standard XML, integrated task panes for research and communication, and expanded Smart Tag capabilities help bring relevant and current business data to the user from within Office system programs. The task panes also provide a platform for business process solutions to be built on top of the familiar Office interface.

The following are some of the benefits of XML:

· Easy exchange of data. XML allows data to be retrieved and used from disparate and otherwise incompatible systems. 

· Simple reuse of data. Reuse of information through XML eliminates the need to re-key or recode, and thereby reduces the time required and errors generated in repurposing information.

· Easily searchable information. XML helps give structure and meaning to electronic information, so that information becomes much easier to search and organize.

· Different views of the same data. Because XML separates content from its presentation, the same information can be used in different environments, formats, programs, and devices, depending on the user's needs.

· Rapid solution development. Because more structured information uses the industry-standard XML data tags, business applications can be written from the ground up by developers, or even generated by experienced users, more quickly and easily. 

New feature highlights

The new support for XML in Office Professional Edition 2003 is broad and deep across several products—in ways that are groundbreaking for desktop software. 

Structure data and creating solutions

Office Professional Edition 2003 provides support for customer-defined XML Schema Definitions (XSDs), meaning power users and developers can structure their data in a way that makes the most sense for them, and companies can create integrated business solutions inside documents that interact with other valuable XML-based Web services that any user can take advantage of, even without knowing anything about XML.

Retain rich formatting in documents

Microsoft Office Word 2003 can open and save files in any XML schema. When saving as XML, users also have the option to include, in addition to their own XML data, XML that describes the document formatting by using the WordML schema. Including WordML lets users retain all the rich Word formatting when saving in XML format, so users can open the file and continue editing later with no loss of fidelity. The XML file can also be opened later in another program for searching or reuse of document fragments. A developer can build a document template that contains embedded XML, and anyone who uses that template will then produce valid XML output without knowing anything about XML. A collection of XML documents can be searched as readily as a database, enabling businesses to unlock the information that is stored in documents across the organization. This turns Word into a powerful tool for managing, modifying, and formatting business data.

Define XSDs for exporting data

Microsoft recognizes that each customer has an individualized approach to business and uses specific types of documents and data. For example, a purchase order document for an automotive parts supplier is a very different document from a legal contract written in a law firm.

Accordingly, the XML support in Office Professional Edition 2003 is not merely a way to save the formatting of a document. Instead, the Office programs allow a solution developer or power user to incorporate the actual structure of business data that is used by a particular customer in that customer's documents. This is done by creating or using an existing XML schema that identifies the parts of a document. In the case of the purchase order, these parts might include the customer name, ID number, item description, item ID, quantity, price, and so on.

After these parts of a document are identified in a template, anyone using that template or solution—even someone without any knowledge of XML—will be processing and creating XML data in the format that best suits the particular business needs. The data can then flow directly into business systems and processes.

In contrast to this, the “native schema” for Word or other programs is the schema that is used to contain the formatting for the document so it can be saved and reopened in Word without loss of fidelity. To make this most accessible for customers who may want to use this formatting information, the schema (or file format) is fully documented in the Office 2003 developer tool kit.

For users who want to extract data from one or more tables in a database, Microsoft Access is the most appropriate Office tool. With Microsoft Office Access 2003, users can browse through related tables in a database and choose how to export data by defining the structure of a customer-defined XSD.

Key Functions Enabled by XML in Office Professional Edition 2003

Support for XML in Office Professional Edition 2003 helps seamlessly integrate data into related documents, spreadsheets, and databases, streamlining business processes. Along with providing full access to standard XML features, new XML-based tools in Word 2003, Excel 2003, and Microsoft Office Access 2003 help users interact with data and documents more easily. 

Free up critical business information

Time and again, businesses have expressed the need to capture important business information in a way that allows them to reuse it in other documents or business processes, regardless of servers, programs, or platforms. To fulfill this need, Microsoft has built XML into the heart of Office Professional Edition 2003 programs by creating and enhancing the following features: 

· XSDs. Support for standard and user-defined XSDs better enables data to fit needs.

· Research task pane. Efficient access to relevant data increases productivity.

· Smart Documents. Enabling custom solution development and deployment streamlines business processes.

· Programmable task panes. Displays of relevant tasks and information help automate daily work.

· Real-time data. Real-time updates to data that is inserted from other sources helps reduce valuable time spent on research.

· Smart Tags. Information and action options that function while data is being entered help automate work.

Support for XSDs

XML markup can be used to create "semi-structured" documents with regions of meaning, in addition to presentation and formatting. By creating or using specific XML schemas that define the structure of the document and the type of content that each data element contains, businesses can customize data presentation for their own use, making it easier to manipulate, search, and reuse information. XML bridges the gap between unstructured documents and rigidly structured data.

The World Wide Web Consortium (W3C) has created a standard for generating and describing XML schemas that is known as the XML Schema Definition Language, or XSD. Because each company knows best what type of data it needs to capture, it can define for itself the XSDs that are most relevant to its own business. This is called a “customer-defined schema,” as compared to one that Microsoft or another vendor has defined. Being able to define schemas is a critical business advantage.

By making it possible for businesses to capture the kind of information they need in a richer, more semantic, and structured way, Office 2003 Editions enable businesses to work with information in whatever way makes sense to their organization. For example, with Office 2003 Editions, a human resources system may have Word document resumes that are marked up with XML tags such as “name,” “address,” “career goals,” or “qualifications.” Once the Word documents are submitted to the system, a human resources director can run queries as rich as a database against the collection of XML resume files: Who has an MBA? Who speaks Polish? The human resources director can also use Excel to build charts, summary reports, and more from the data that is contained in those documents.

These schemas can and often will be internal and unique to a company, such as an order-processing schema or a research report schema. But in some industries, it makes sense to create schemas for use among multiple companies or organizations. One example is XBRL, which stands for eXtensible Business Reporting Language, an open specification that uses XML schema to describe financial information. Another example is HL7, which is used in the healthcare industry. Having these standard schemas in place allows different organizations to easily share information, even if they are using completely different technologies from different vendors on different platforms. The standard schemas also create other communication and business efficiencies.

Research task pane

The Research task pane uses XML to provide a way for organizations to expose relevant internal business information and processes, and information from other relevant sources, directly in the context of each Office 2003 program.

Developers within an organization can create and deploy services by using XML that plugs directly into the Research task pane on computers that are running Office 2003 Editions. Services can include anything from data accessibility to interactive forms. An organization can also subscribe to vendor Web services that give personnel access to even more information in the Research task pane.

Developers can make services available to users over the Internet, through a corporate intranet, or by installing the services directly on a user's computer. Services that are available over a network, Internet, or intranet are better for information that may change frequently or is used by a large audience.

Services can be deployed manually, be discovered automatically by a user's computer, or be pre-registered when an Office 2003 Edition is installed on a computer. With manual deployment, a user navigates to a URL and registers for the service. With discovery, the user is prompted to register for a new service automatically. When a service is pre-registered, no user intervention is required.
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The Research task pane in Office 2003 Editions.

Smart Documents

Smart Documents are XML-based solution development and deployment platforms that are available in Word 2003 and Excel 2003. Smart Documents help developers tackle business-process problems by quickly building document-based solutions that combine the advantages of the Word and Excel desktop programs with the advantages of Web services. Benefits of these solutions include easier deployment and updating of the solution, and a larger selection of tools for solution development.

Smart Documents bring relevant information directly to the task at hand through a new Programmable task pane user interface. With Smart Documents, XML solutions can be created to enable business processes and help users complete forms and other documents, and then link that information to back-end systems that support XML. As the user clicks through the document, the program modifies itself to present the appropriate functions and help complete a task.

Smart Documents can easily be incorporated into business processes such as expense reporting, contracts, or anything else that might pass through multiple hands or systems while being authored, or that require information from back-end sources. A Smart Document solution can also include custom Smart Tags that are designed specifically to run only in that solution, or any other code that the developer would like.
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Smart Documents use the new Programmable task pane shown on the right to bring relevant information directly to the user.

Using Smart Documents makes solution deployment much more flexible. Solution code can now be deployed once to a central server location, and Word and Excel will securely download and cache it locally when the Smart Document is opened. Updates to the solution code and even the document template itself can be delivered the same way, as a single update to the server location for the Smart Document solution, without having to deploy directly to hundreds or thousands of clients, just as with Web-based solutions. But unlike Web-based programs, the Smart Document solutions can operate even when the computer is offline because they use the Office programs rather than a browser. In addition to solutions based on the Component Object Model, Smart Documents also accept solutions that are written in Microsoft Visual Basic® 6.0, Microsoft Visual C#®, Microsoft Visual C++®, and Microsoft .NET managed code for additional security and ease of development.

Smart Documents are new, and their use is virtually unlimited. The following are a few example scenarios.

· A purchase order solution using Excel might be linked to a business rule in a back-end server that takes the User ID and applies the user's current signing limit to the order directly in Excel, while the user is completing the form. 

· A social services solution could be created that translates forms into different languages or assists applicants in completing the form, with context-sensitive help. 

· Depending on the user type or ID, or on input from the user, a Word document could reconfigure itself to include the necessary sections that the user needs to complete—for example, a performance review form that has different sections for management and employees.

Programmable task panes

Developers can create custom actions for each section of a document based on the XML elements of the particular document and then make the actions available to users in a Programmable task pane. The task pane ties different controls to different parts of the document, revealing the most relevant services for each part while the document is being developed. For example, developers can build actions that display help text, ask for input (using standard Microsoft Windows controls like check boxes and text fields), or retrieve data from other programs or back-end servers. After the user enters the data that is necessary for a task, the Smart Document can perform actions such as looking up data, formatting it according to the document’s template, and placing it in the document.

As the user moves from section to section in the document, tasks and information that are relevant to a document or spreadsheet appear in the task pane, helping streamline and automate what may currently be lengthy day-to-day business processes. The task pane gives the user control over which actions are invoked and when, such as manipulating data in the document; and making database queries, or interacting with line-of-business systems.
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A sample Smart Document for writing proposals. The Programmable task pane on the right is built to aid with the task of writing a proposal.

Real-time data

In a Smart Document, experienced users or template and solution creators can easily keep their documents current by creating dynamic charts and graphs that draw on up-to-date, real-time data from back-end systems to display business information as it changes, or they can create reports with up-to-the-minute information. Users can insert and manually refresh this data from the Research task pane or from a custom solution that is created for the purpose.

For example, a financial analyst writing a report can use the Research task pane to locate all the latest financial information about a particular organization and insert it into the report. Later, the analyst can easily update the data to reflect any changes that occurred after the report was written.

Smart Tag capabilities

As in Microsoft Office XP, Smart Tags in Office Professional Edition 2003 recognize certain words or strings as they are entered (such as a name, an address, or a stock ticker) and allow users to choose information and actions to associate with that entry. For example, a user can select an action, such as turning part numbers into hyperlinks in a sales database, adding properly formatted citations to the end of a research paper, or automatically populating an index with every person, company, or product that is mentioned in an article.

In Office Professional Edition 2003, Smart Tag support has been increased to include Access, PowerPoint, and Outlook. In addition, Smart Tag support is included in new features such as the Research task pane and Shared Workspaces. 
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A Smart Tag is indicated by a series of purple dots under the text. Clicking the SmartTag provides context-sensitive options.

In Word 2003 Smart Tags integrate with XML support, and Smart Tag actions can be linked to XML elements in documents or spreadsheets. Word also extends the functionality of Smart Tags to apply to XML elements directly, so actions can be provided for entire sections of documents rather than just a few words, and actions can work on “types” or collections of data rather than relying on text recognition. For example, a custom Smart Tag can be written that appears on fields that require the user to enter data and then offers to pre-populate the data. A Smart Tag action can also be provided that applies different transforms or views on XML data that the Research task pane retrieves.

Using Smart Tags in Office XP, independent software vendors (ISVs) and users have extended Smart Tags in ways that are specific to certain industries, such as facilitating the ability of a medical facility to look up patient records from a database by using names or ID numbers. Companies have also developed specialized capabilities using Smart Tags such as the ability to display customer data based on customer ID, or show inventory and sell-through for a particular stock-keeping unit number. Office Professional Edition 2003 extends the capabilities of Smart Tags even further and brings that functionality to more programs, for the benefit of both users and developers. 

XML in Word 2003

The deep support for XML in Word 2003 creates a new metaphor for documents: bridging the gap between documents and data. XML in Word provides the basis for building solutions for a wide variety of business problems, such as consistent forms and reports, data reporting, content aggregation, publishing, data mining, and data submittal to business processes. 

Structured documents and content authoring

An efficient method of streamlining business processes is the implementation of standard tools across departments, including forms and reports. To support this goal, Word 2003 includes the ability to limit the formatting that can be used in a document and to limit the parts of a document a user or users can edit. In this way, Word can be used as a data input tool for XML-based business processes.

For example, with a financial services template, the creator of the template can lock the parts of the document that explain how to fill it out and can even limit the kinds of formatting the user can apply. After the customer completes the rich Word document within these enforced guidelines, it can be submitted to a Web service or internal server tool that collates the information the user submitted; this is because the data is pure, valid, well-formed XML, which means that other business systems can use it easily.

Capabilities and benefits

Much of an organization’s knowledge lies in documents that are created by individuals in the organization, and those documents are generally stored where access is relatively difficult for anyone other than the creator of the document. Predictions about exactly which bits of information are going to be valuable in the future are also difficult. When documents are stored as XML files, this information can be “mined” at a later date as appropriate. For example, a user could pull all the graduation dates out of a collection of resumes in a particular XML schema with a simple query. Doing this with HTML or normal word processing documents (in binary or native XML without customer-defined schemas) would be difficult if not impossible.

In addition to the support for customer-defined schemas in Office Professional Edition 2003, Word 2003 provides a native XML file format—a valid, well-formed XML file that fully represents a Word document. With Word 2003, users can save resumes, reports, or other documents as XML files and retain Word’s rich formatting when the file is opened again. No features or formatting are lost when saving a Word document as XML, and only a single file is created. This makes it much easier to share or work with the document than with the HTML format, where images and other files are stored separately. 

To maximize the usefulness of a document, one document often appears in different contexts or on different devices. For example, a company’s annual report might go out to shareholders in a rich printed form, be available from its Web site in a simpler form that works with all Web browsers, and even be available for display on devices with small screens, such as Pocket PCs.

Word 2003 defaults to saving in the *.doc binary format, which can be read by more than 300 million Word users worldwide. Word can be configured to default to any of several other formats, either through corporate policy or by end-user choices. An option that exists in Tools/Options/Save forces Word to always save in XML, for example. Further, a solution builder can control Word so that it always saves as XML to a content repository but allows the end user to save as *.doc locally, if that is what the user prefers.

The Word XML file format is useful in itself as a way to enable access to the content of documents without requiring Word (such as when WordML documents are stored on a server, and the server needs to query the document content). In addition, a significant part of its value is to act as a container for the customer-defined schema data. When using a customer-defined schema, the Word XML acts as a transparent “envelope” that carries the more valuable customer data, providing information about how it should be presented (for example, formatted in a table). When used with customer-defined XML data, Word XML also adds the capability to execute complex operations on customer data, such as merging two XML documents and storing the differences, or tracking changes on XML data as it is modified by multiple users—capabilities that are not available today in other products.

Using Word 2003, users can open a preexisting, customer-defined XML file while retaining the file’s own schema, or they can create a new file by applying an XML schema to an existing Word document or template. Word also allows users to see the XML elements that have been applied to a document along with a list of elements that can be applied to the current selection. This list is taken from the schema that has been applied to the document. By default, it shows only those elements that are valid according to the schema in the selected context. 

Word’s support for customer-defined schemas allows the customer’s data to remain in the document while it is edited and to be extracted later on. This is much more powerful than a method where the customer data is transformed into formatting or styles in a document. Word 2003 also supports the use of XSL Transforms (XSLTs) for converting files.

Users can employ XSLTs to produce multiple formats from one master XML copy of the document. The advantage of this approach is that users do not need to make edits in multiple copies of the document. Instead, a Web server can use different transforms on the master XML document depending on the viewing device, so the user edits the master and lets the transform take care of the appropriate presentation. Similarly, the XSLT can be changed in order to change the appearance of the document without having to worry about introducing errors into the original. The user can also manually create the different versions by doing a Save As “through” the different XSLTs.

A document that uses a customer-defined schema (from an XSD) can be saved in one of the following ways:

· In XML using only that schema (no Word XML included); this is considered “pure data.”

· As a WordML file with the customer-defined XML interspersed and separated by using XML namespaces. The WordML can be easily removed through a transform or programmatically at any time, leaving only the XML in the original schema for easy manipulation by outside processes, such as a server mining the document for data.

As XML markup, which also conveniently persists in the binary *.doc and *.dot formats for easy transport and storage, as well as provides a document that can be opened, viewed, and edited in older versions of Word (although the customer-defined XML will be lost if the document is changed and saved).
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An advanced Word user marking up a template with the user's own XML schema. The tag view is turned on and the XML structure pane is visible. Later on, a consumer of this template would not see any tags or the XML structure pane, but would fill out the template normally and see the appropriate markup on the content.

In addition, Word 2003 will automatically detect associations among XML files and schema files (XSDs) and give users the option to attach the appropriate XSDs or use applicable XSLTs when it encounters XML files that belong to categories that are registered with Word, such as news articles or resumes. With this feature, a user can open an XML file, and Word will automatically apply an XSL Transform to display it in an organization’s standard format if an association has already been made. 

For reporting data, Word 2003 supports refreshable XML Web queries. The results of the queries can be passed through an XSL Transform for display in Word using its rich formatting capabilities. Users can take advantage of this capability to present, inside a weekly report or other document data such as server-side SharePoint data (available as XML from SharePoint), other XML data from any Web service or database, ASP/ASPX pages, or other sources. For example, a user can include a table in a document that shows the current status of the document on a SharePoint site, the author, priority, due date, and more, and this information can be updated automatically to keep it in sync with any changes on the server.

Working with XML files, Word 2003 can now become an integral part of an organization’s content-management solution. Users can create XML content by using the familiar Word program. Word’s task pane can also show fragments of XML documents that can be recombined or inserted into the current document to simplify the reuse of content across the organization. Developers can easily create solutions to manipulate, distribute, and repurpose this content as needed by using tools such as Visual Basic for Applications (VBA) or even Visual Studio® .NET Tools for Office and the robust Word XML object model.

Summary

Support for XML in Office Professional Edition 2003 simplifies business processes by making information accessible in multiple formats and in multiple programs. By enabling user-defined XSDs and XSLTs, organizations can also customize data output to meet their specific needs. With the added benefits and features of XML, Office Professional Edition 2003 can be the premier choice for businesses.

Introduction

With information in hand about how Microsoft Office 2003 Editions help users connect people, it is important to look at the new features Microsoft Office Word 2003 delivers to its users. These features are individually described within the following sections.

ClearType

Reading Layout view and Print Layout view use Microsoft ClearType® to display type in Word 2003. ClearType is a typographical technology that is ideal for portable computer monitors and other flat-screen monitors. With ClearType, text may appear slightly blurry on older desktop-computer monitors. If users are working with a flat-screen monitor, they will need to ensure that ClearType is enabled in Windows.

[image: image9.png]use the follwing transition effect for menus and tookips:

Fade offect v

Use the Follawing method to smacth ediges of screen fonts:

ClearType v
O I

how shadows under menus

how window contents whil dragaing

Fide underined letters for keyboard navigation untl 1 press the Al key





The clarity and sharpness of ClearType is ideal for portable computer monitors and other flat-screen monitors.

How to enable ClearType in Windows XP

1. In Windows Control Panel, click Appearance and Themes, and then click Display. 

2. Click the Appearance tab, and then click Effects. 

3. Select the Use the following method to smooth edges of screen fonts check box, and then click ClearType. 

Reading Layout view

If users are opening a document primarily for reading, Reading Layout view optimizes the reading experience. Reading Layout view hides all the toolbars except for the Reading Layout and Reviewing toolbars. Because the goal of Reading Layout view is to increase legibility, pages that are represented in this view are designed to fit well on the screen, and the text is automatically displayed by using Microsoft ClearType technology. Users can easily increase or decrease the size in which text is shown without affecting the size of the font in the document. 

If users want to modify the document, they can edit text while reading without switching out of Reading Layout view. The Reviewing toolbar is automatically displayed in this view, so users can easily use change tracking and comments to mark up a document.
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To improve the reading experience, the pages in Reading Layout view fit well on-screen, and the text is displayed by using Microsoft ClearType technology.

How to switch to the Reading Layout view

4. Click Read [image: image11.png]] Read




on the Standard toolbar.

5. To stop using the Reading Layout view, click Close [image: image12.png]03 Close.




on the Reading Layout toolbar, or press ESC, or press ALT+C. 

-or-

6. Press ALT+R in any view in Word.
7. To stop using the Reading Layout view, click Close [image: image13.png]03 Close.




on the Reading Layout toolbar, or press ESC, or press ALT+C. 

Merge enhancements

The Mail Merge task pane helps users create form letters, mailing labels, envelopes, directories, mass e-mail, and fax distributions. The Mail Merge Wizard is easy to use and provides step-by-step instructions, but users can also take advantage of the Mail Merge toolbar. In either case, users can follow the process by looking at the numbered steps at the bottom of the Mail Merge task pane.
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Use the Mail Merge task pane to create mass e-mail messages or mailing labels.

How to open the Mail Merge task pane

8. On the Tools menu, point to Letters and Mailings, and then click Mail Merge. 

Track changes enhancements

To make online review easier, Word 2003 allows users to make and view tracked changes and comments in a document. To preserve the layout of a document, Word 2003 shows some markup elements in the text of the document while others are contained in balloons that appear in the margin. The Reviewing pane shows an outline of all the edits in a list format at the bottom of the screen.

With the Track Changes feature turned on, each insertion, deletion, or formatting change that a reviewer makes is tracked. As tracked changes are reviewed, users can accept or reject each change. Users can also use the Display for Review drop-down box to view the document during various stages of the review process. 

[image: image15.png]Fomst  Tools Table Window Help

A4 Normal +Line s - Times NewRoman < 12 - | B Z |

o @R Q- AAY mﬂ!





Turn on Track Changes when reviewing a document.

How to track changes

On the Tools menu, click Track Changes to open the Reviewing toolbar.
-or-
Click Track Changes. 
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Select the desired review setting for a document.

How to view the document during various stages of the review process

On the Reviewing toolbar, select the desired setting from the Display for Review drop-down list. 

Ink support

If users are working on a Microsoft Tablet PC, they can use a tablet pen to add drawings or handwritten notes to Word 2003 documents—in comments, in the content of a document, or as annotations about content that already exists in the document.
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With a Tablet PC, handwritten comments can be added to a Word document.

How to use Ink

To write directly in a document: 

9. On the Insert menu, point to Picture.

10. Tap Ink Drawing and Writing. 

To insert an Ink comment: 

On the Insert menu, tap Ink Comment. 

Use one of these methods to make Ink annotations: 

11. From the Print Layout view, go to the Insert menu.

12. Tap Insert Ink Annotation. 

13. Mark up the document similar to how you would do so on paper. When you are finished, tap Stop Inking on the Ink Annotations toolbar.

-or-

14. From the Reading Layout view, go to the Reading Layout toolbar. 

15. Tap Actual Page. 

16. On the Reviewing toolbar, tap Insert Ink Annotations.

17. Mark up the document similar to how you would do so on paper. When you are finished, tap Stop Inking on the Ink Annotations toolbar.

Formatting restrictions

In Word 2003, users can specify and enforce template or document styles by using the Formatting Restrictions feature. All direct formatting will be disabled. Complex documents can be edited by many people and still retain structured formatting.

[image: image18.png]Protect Document. v x

1. Formatting restrictions

Lt formatting to a seection of
styles

Settings.

2. Editing restrictions

] allow only this type of editing in
the document:

3. Start enforcement

Are you ready to apply these
settings? (You can turn them of
later)

Ves, Start Enfordng Protection

Seealso

Restrict permission.




Use the Protect Document task pane to specify the styles that a template or document uses.

How to restrict formatting

18. On the Tools menu, click Protect Document. 

19. In the Protect Document task pane, under Formatting restrictions, select the Limit formatting to a selection of styles check box, and then click Settings.

Editing restrictions

With editing restrictions in Word 2003, users can protect portions of a document against editing by some or all users. Editing restrictions options include protecting the entire document against any edits, allowing only comments, and assigning permissions to individual portions of the document by selecting them and choosing which users can edit a designated area. Later, when reconciling the changes of different individuals, users are assured that no two people edited the same area and that no conflicts exist.

After the restrictions have been set up, the Protect Document task pane helps users find the sections they can edit.
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Set the restrictions on all or portions of a document.

How to restrict editing

20. On the Tools menu, click Protect Document. 

21. In the Protect Document task pane, select the Editing restrictions check box, and then click one of the following: 
No changes (read only) (if you want to prevent users from changing the document) 
-or- 
Comments (if you want to allow users to insert comments into the document but not change the content of the document) 

-or- 
Track Changes (if you want to allow users to insert comments into the document and add tracked changes) 

-or- 
Filling in forms (if you want to allow users to fill in a form but not make changes to the form) 

22. If you select No changes (read only) or Comments, go to the Exceptions area and assign permissions to individual portions of the document by selecting those portions and then choosing which users can edit them.

23. If you select Filling in forms, you can remove protection from sections of the form by clicking Select sections and clearing the checkboxes for those sections you do not want to protect. To protect only parts of a form, those parts must be in separate sections.

24. Click Yes, Start Enforcing Protection.

As this section demonstrates, Word 2003 is rich in features and easy to use. Users who require assistance with Word 2003 can get online help and services for Office 2003 Editions, as described in the next section.
Online Help and Training

Microsoft Office 2003 Editions offer new and improved integration with Microsoft Office Online Web services. More powerful, better integrated, and with an improved online interface, these services are seamlessly available from within Office 2003 programs. The Web site, also available through a browser at www.microsoft.com/office, offers a resource page for each Office 2003 Editions program. The resources pages have assistance, columns, training, and templates.

Help

The Help system of Office 2003 Editions has been extended beyond individual workstations. If a user is connected to the Internet when choosing a Help topic or entering a word in the Ask-A-Question box, the Help system displays not only the Help information from the local system, but also brings to the Help window information from the Microsoft Web site (www.microsoft.com). This provides the most current information on the topic that the user needs help with, in addition to links to other resources.

Assistance

The Assistance Web page provides up-to-date information with How To articles, conceptual topics, columns, and helpful tips for common tasks. Users can find answers to common questions, read articles on features in Office 2003 Editions, look for specific help in newsgroups, or suggest a topic for a future article.

Office Online Training

The Training site offers Web-based interactive training courses and self-paced exercises. Users can develop deeper knowledge of tasks and application features, such as creating an outline in Microsoft Office Word 2003 or using motion paths in Microsoft Office PowerPoint 2003 slides. Courses include practice sessions where users can give things a try in the actual program, and short tests to assess comprehension. Courses cover a variety of topics, and are available for any Office 2003 Editions program.
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Use Office Online to find training opportunities for Office programs.

Downloads

On the Downloads site (formerly known as Office Update), users can check for free updates that improve the stability and security of Office 2003 Editions. On the Downloads home page, users can click Check for Updates to start the automatic detection tool, which scans the computer and then returns a list of new downloads that are available and compatible with the user's version of Office. In addition to security and performance updates, viewers, converters, add-ins, stationery, and other useful downloads are also available. The most popular downloads are listed in the Popular Office Downloads section.
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